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Getting Started
Front/Rear View:

WEEE LOGO

Disposal of Old Electrical & Electronic Equipment
(Applicable in the European Union and other European
countries with separate collection systems )

This symbol on the product or on its packaging indicates that this product
shall not be treated as household waste. Instead it shall be handed over to
the applicable collection point for the recycling of electrical and electronic
equipment. By ensuring this product is disposed of correctly, you will help
prevent potential negative consequences for the environment and human
health, which could otherwise be caused by inappropriate waste handling of
this product. The recycling of materials will help to conserve natural
resources. For more detailed information about recycling of this product,
please contact your local city office, your household waste disposal service or
the shop where you purchased the product.
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Software Installation
»Operation System Requirements

Windows XP SP2 (support USB2.0 audio class)
Windows 2000 (not support USB2.0 audio class)

1. Insert the PC1331 WebCam software CD into the CD-ROM
drive of your computer.

2. The installation program will run automatically. If the
installation does not auto play, please run “Setup.exe” from
the CD-ROM’s root directory to install.
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»Driver install
1.

After software installation, the “ArcSoft Software suite”
dialogue box will pop-up on the screen. Click the “PC Camera
Driver” icon to install device driver and then follow the
on-screen instruction to install the driver.
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Please select “Yes, | want to restart my computer now. And
click “Finish” to complete driver installation.

Attention:
It is strongly recommended that you restart your
computer after installing the driver.

»ArcSoft suite Install

1.

Please click “ArcSoft WebCam Companion” icon, and then

follow the on-screen instruction to install the application
software.

The wizard will install ArcSoft suite: four software at the

same time.



3. After first time installation, the system will restart; there will
be a new icon on the desktop.

4. Connect your WebCam to an available USB port on your
computer. Windows should detect your new device.

Hardware Installation

1. Plug the enclosed USB cable into camera and USB port on
PC separately, after installing the PC1331 driver and restart
your PC. (To avoid low voltage, it is recommended that you
plug the USB cable connector to USB port directly into the
PC.)

2. You can find a resident icon on the tool-bar of desktop. By
pressing the icon, you may check the WebCam connection
and working status.

English

Attention:

Please restart Windows if you can’t trigger AMCAP when
you press Snapshot button in Windows XP or update
your Windows with latest service pack.
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3. Press the snap shot button, the blue LED indicator will light
up and the “AMCAP” dialogue Box will pop up when the
installation is successful.

Attention:

If you have more then one image device in your system,
please select the “CamMaestro” as the PC Camera
device.

Function Description

You can use AMCAP or resident icon to select all functions you
need.

Resident icon
@ ©

1. Record:

(1) Video record: Capture-> Start Capture->Stop Capture



(2) Video and Audio record:

1st Step: Please select the microphone first.

-Windows XP user:
You can use the build in audio directly and then set up:
AMCAP->Device>USB2.0 Camera

-Windows 2000 user:

Windows not support USB2.0 Audio class and you will
need to plug your own microphone into microphone
connector of PC. And then set up:

AMCAP->Device>sound card

2nd Step: Capture->Capture Audio-> Start Capture
2.Snapshot:

(1) Please press the snap shot button or press resident icon to
capture.

(2) Interpolate still image to 2.0M or 4.0M pixels:

You will need to select “output size” to 1.3M(1280x1024) first.
AMCAP -> Option - Video Capture Pin - Output size

And then select "VGA Snapshot” to 2M or 4M,and press the
snapshot to capture.

AMCAP - Option = Video Capture Filter > VGA Snapshot
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Special Effects

1.Effects:

m
-
Q
=
=

You can have multiple choices of these effects to enrich your
pictures. Please follow the steps below to set the “Effects
Functions”.

AMCAP -> Option->Video Capture Filter> Effects



2.Zoom in/out functions:

Please follow the on screen instructions to select the Zoom in /
Zoom functions.

AMCAP - Option - Video Capture Filter > Zoom

3. Face Tracking:

Besides the Zoom function, there is a special Face Tracking
function. Check the “Enable Face Tracking function” and then
remain still for at least 10 seconds. The lens will then focus on
your face and track your every movement.

AMCAP - Option -> Video Capture Filter>Enable Face
Tracking function
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Notice:

1.Power Source Adjustment:

Choose the mode of “50Hz" or “60Hz" according to your power
source environment or video output signal system to avoid the
blurry image.

AMCAP->Option>Video Capture Filter-> Settings

2.Please download the latest update of “Service Pack” (from Start
- Windows Update) to keep the camera running smoothly.

3.1f the resident icon is shut, you will need to restart your computer
to have this function.

4.Support of USB 2.0 audio class (Audio build in) with Windows XP
SP2 only.

5. For ArcSoft application software, just support Video and Audio
record at Windows XP SP2 only. For Windows 2000, just can do
video record.

6. Support function of Zoom and Face tracking under VGA mold
(640x480).

7. Stillimage capture to 1.3M/2M/4M just by USB2.0 port.

8. Avoid the Snapshot not work normally at first Installation in
Windows XP. Please check the video capture function with
AMCARP first or restart Windows
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Pour Commencer

Vue avant/arriére

Support

Mise au
point
LED " Connecteur
usB
Cliché

E Disposal of Old Electrical & Electronic Equipment (Applicable in
the European Union and other European countries with separate
mmmm  collection svstems)
Ce symbole sur le produit ou son emballage indique que ce produit ne sera
pas traité comme les déchets du ménage. Il doit étre remis au local de
collection de recyclage d'équipement électrique et électronique. Pour assurer
que ce produit est disposé correctement, vous devez empécher des
conséquences négatives potentielles pour l'environnement et la santé
humaine, qui pourrait étre causée par le traitement de déchets inapproprié de
ce produit. Le recyclage de matériels doit aider a conserver des ressources
naturelles. Pour des informations plus détaillées sur le recyclage de ce
produit, entrez en contact avec votre bureau local de la ville, le régie de
disposition d'ordures du ménage ou le magasin ou vous avez acheté le
produit.
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Installation logicielle

»>Systéme d’exploitation requis
Windows XP SP2 (prise en charge de la classe audio USB2.0)
Windows 2000 (prise en charge de la classe audio USB2.0)
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1. Insérez le CD du logiciel Web Cam PC1331 dans le lecteur de
CD-ROM de votre ordinateur.

2. Le programme d'installation démarre automatiquement. Si
l'installation ne se lance pas veuillez lancer “Setup.exe” a
partir du répertoire racine du CD-ROM pour installer.

e ey gy —)
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> Installation du pilote

1. Aprés linstallation logicielle, la boite de dialogue “Suite
Logicielle ArcSoft” s'affiche a I'écran. Cliquez sur licéne
“Pilote PC Camera” pour installer le pilote de périphérique
puis suivez les instructions a I'écran pour installer le pilote.
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2. Veuillez sélectionner “Oui, je veux redémarrer mon ordinateur
maintenant. Et cliquez sur “Terminer” pour terminer
I'installation du pilote.

Attention:
Il est fortement recommandé de redémarrer I'ordinateur
aprés avoir installé le pilote.

»Installation de la suite ArcSoft

1. Veuillez cliquer sur 'icbne “Compagnon Web Cam ArcSoft”,
puis suivrez les instructions a I'écran pour installer le logiciel
d’application.




2.

L’assistant installe la suite ArcSoft: quatre logiciels en méme
temps.

Aprés le premiére installation, le systétme redémarre, une
nouvelle icbne apparait sur le bureau.

i
Branchez votre Web Cam sur un port USB disponible de
votre ordinateur. Windows devrait détecter votre nouveau
périphérique

Installation matérielle

1.

Branchez le cable USB fourni sur la caméra et sur le port
USB du PC séparément, aprés avoir installé le pilote
PC1331, et redémarrez votre PC.

(Pour éviter les faibles tensions, il est recommandé de
brancher le connecteur du cable USB sur le port USB
directement sur le PC.)

Vous trouverez une icone résidente dans la barre d’outils du
bureau. En cliquant sur l'icone, vous pouvez vérifier I'état de
fonctionnement et de connexion de la Web Cam.

14

Francais



Attention:

Veuillez redémarrer Windows si vous ne pouvez pas
déclencher AMCAP en appuyant sur le bouton Cliché de
Windows XP ou mettez a jour Windows avec le dernier
service pack.
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3. Appuyez sur le bouton de cliché, lindicateur LED bleu
s’allume et la boite de dialogue “AMCAP” apparait lorsque
l'installation a réussi.

Attention:

Si vous avez plus d'un périphérique image sur votre
systeme, veuillez sélectionner le “CamMaestro” comme
périphérique PC Caméra.

Description des fonctions

Vous pouvez utiliser AMCAP ou licone résidente pour
sélectionner toutes les fonctions dont vous avez besoin.

A o D P 19,
Icone résidente -

@ < o

T
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1.Enregistrer:
(1)Enregistrement vidéo:
Capture->Démarrer capture->Stop Capture
(2) Enregistrement vidéo et audio:

1ére étape: Veuillez d'abord sélectionner le microphone.
-Utilisateurs de Windows XP:
Vous pouvez utiliser l'audio intégré directement puis
configurer:
AMCAP->Périphérique->Caméra USB2.0

-Utilisateurs de Windows 2000:
Windows ne prend pas en charge la classe audio USB2.0
et il vous faut brancher votre propre microphone sur le
connecteur microphone du PC. Puis configurez:
AMCAP->Périphérique—>carte son
2°™ étape: Capture>Capture Audio>Démarrer Capture

2.Cliché:

(1) Veuillez appuyer sur le bouton de cliché ou appuyez sur
I'icbne résidente pour capturer.

(2) Interpoler la photo de 2.0M a 4.0M pixels:
Il vous faut d'abord sélectionner la “taille de sortie” sur
1.3M(1280x1024).
AMCAP - Option = Pin Capture Vidéo - Taille de sortie

16
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Puis sélectionnez "Cliché VGA” sur 2M ou 4M, et appuyez sur
Cliché pour capturer.
AMCAP - Option - Filtre Capture Vidéo - Cliché VGA
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Effets spéciaux

1.Effets:

Vous pouvez avoir de multiples choix d’effets pour enrichir vos
images. Veuillez suivre les étapes ci-dessous pour régler les
“Fonctions effets ".

AMCAP - Option - Filtre Capture Vidéo > Effets
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2.Fonctions Zoom plus/moins:

Veuillez suivre les instructions a I'écran pour sélectionner les
fonctions Zoom plus / moins.
AMCAP - Option - Filtre Capture Vidéo - Zoom

2
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3. Suivi de visage:

En plus de la fonction Zoom, il y a une fonction spéciale de suivi
de visage. Cochez la case “Activer la fonction de suivi de visage
puis laissez libre pendant au moins 10 secondes. L'objectif fait
alors la mise au point sur votre visage et suit chacun de vos

mouvements.
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AMCAP -> Option - Filtre Capture Vidéo->Activer la fonction de
suivi de visage

Notice: mise a I’échelle
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1.Réglage de la source d'alimentation:
Choisissez le mode “50Hz" ou “60Hz” selon I'environnement
d’'alimentation ou le systole de signal de sortie vidéo pour éviter
limage floue.

AMCAP -> Option - Filtre Capture Vidéo> Réglages

2.Veuillez télécharger la derniére mise a jour du “Service Pack” (a
partir de Démarrer > Windows Update) pour que la caméra
continue de fonctionner correctement.

3.Su licone résidente est fermée, il vous faut redémarrer
I'ordinateur pour avoir acces a cette fonction.

4.Prise en charge de la classe audio USB 2.0 (Audio intégré) avec
Windows XP SP2 uniquement.

5. Pour le logiciel d’application ArcSoft, prise en charge seulement
de l'enregistrement vidéo et audio sous Windows XP SP2
uniguement. Pour Windows 2000, enregistrement de vidéo
uniquement.

6. Prise en charge de la fonction de Zoom et de Suivi de visage
sous le mode VGA (640x480).
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7. Capture de photos jusqu’a 1.3M/2M/4M simplement par le port
USB2.0.

8. Pour éviter que le mode cliché ne fonctionne pas normalement a
la premiére installation sous Windows XP. Veuillez vérifier la
fonction de capture vidéo avec AMCAP d’'abord ou redémarrez
Windows.

20
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SO FANGST DU AN

Frontseite/Rickansicht

Aufsteller

|LED === USB-
Anschluss

I
Schnappschuss

Beseitigung der alten elektrischen & elektrischen Ausristung
(anwendbar auf die Europaische Union und andere europdische
Lander mit dem separaten Sammlungssystem)

Das Symbol auf dem Produkt oder in der Verpackung zeigt, dass das Produkt
nicht als Hausmill behandelt werden soll. Im gegenteil soll das als das
Recycling der elektrischen und elektronischen Ausriistung in die
verwendbare Gesamtstelle Uberreicht werden. Sie helfen vor potenzielle
negative Folgen fur Umwelt- und Menschgesundheit zu schitzen, so dass
das Produkt richtig behandelt wird. Sonst wird die unrichtige Behandlung fur
das Produkt verursacht. Das Recycling der Materialien helfen naturale
Quellen zu bewahren. Fir mehre ausfuhrliche Information des Recyclings
dieses Produkts schaffen Sie mit lhrem lokalen Stadtbiro, lhrem
Behandlungsdienst des Hausmiills oder dem Geschéft Kontakt, wo Sie das
Produkt kauften.
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Softwareinstallation

Kompatible Betriebssysteme
Windows XP SP2 (unterstiitzt USB 2.0-Audioklasse)
Windows 2000 (keine USB 2.0-Audioklassenunterstiitzung)

Achtung:
Installieren Sie den Treiber, BEVOR Sie die Kamera mit

dem USB-Port verbinden.

1. Legen Sie die PC1331 WebCam-Software-CD in das
CD-ROM-Laufwerk Ihres Computers ein.

2. Das Installationsprogramm startet automatisch. Sollte die
Installation nicht automatisch starten, fiilhren Sie bitte die Datei
LSetup.exe* im Hauptordner der CD-ROM aus.
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»Treiberinstallation

1.

Nach der Softwareinstallation wird der ,ArcSoft Software
suite“-Dialog auf dem Bildschirm angezeigt. Zur Installation der
Geratetreiber klicken Sie auf das Symbol ,,PC-Kameratreiber‘ und
folgen dann den Anweisungen auf dem Bildschirm.

Scmn bal sl v b e e “

Bitte wahlen Sie ,, Ja, Computer jetzt neu starten.”, klicken Sie
dann zum Abschluss der Treiberinstallation auf ,Fertigstellen*.

Achtung:

Nach der Treiberinstallation sollten Sie lhren
Computer auf jeden Fall neu starten.

»ArcSoft suite installieren

2.

3.

Bitte klicken Sie auf das Symbol ,ArcSoft WebCam
Companion”, installieren Sie die Anwendung dann, indem Sie
den Anweisungen auf dem Bildschirm folgen.

ST py e Ty e————— - — m
- et e il )y e el e

Der Assistent installiert die ArcSoft suite: Dabei werden vier

Anwendungen gleichzeitig installiert.
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Nach dem Abschluss der Installation startet das System neu.
Nach dem Neustart finden Sie ein neues Symbol auf dem
Desktop.

L]

s

SchlieRBen Sie Ihre Webcam an einen freien USB-Port des
Computers an. Das neue Gerat sollte von Windows
automatisch erkannt werden.

Hardwareinstallation

1.

Nachdem Sie den PC1331-Treiber installiert und Ihren PC
neu gestartet haben, verbinden Sie Kamera und PC lber das
mitgelieferte USB-Kabel. (Damit das Gerat ausreichend mit
Strom versorgt wird, sollten Sie das USB-Kabel direkt an
einen USB-Port Ihres PCs anschliel3en.)

In der Taskleiste im unteren Teil des Bildschirms finden Sie
ein entsprechendes Symbol. Sie kdnnen den Verbindungs-
und Betriebsstatus Ihrer Webcam Uberprifen, indem Sie auf
dieses Symbol klicken.
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Achtung:

Bitte starten Sie Windows neu oder aktualisieren Sie lhre
Windows-Version mit dem neusten Service Pack, falls
AMCAP beim Dricken der Schnappschuss-Taste nicht
aufgerufen wird.

Bei einer erfolgreichen Installation leuchtet die blaue LED auf
und das Dialogfenster ,AMCAP* erscheint, wenn Sie auf die
Schnappschuss-Taste driicken.

Achtung:
Falls mehrere bildgebende Gerdte in lhrem System

installiert sind, wahlen Sie bitte ,CamMaestro“ als
PC-Kamera-Gerat alls.

26
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Funktionsbeschreibung

Samtliche Funktionen kénnen Sie tber AMCAP oder das Symbol
in der Taskleiste auswéahlen.

Taskleistensymbol
@ ©

1. Aufnahme:

(1) Videoaufnahme: Erfassung->Erfassung starten->Erfassung
stoppen

(2) Video- und Audioaufnahme:
Erster Schritt: Bitte wahlen Sie zunéchst das Mikrofon.

- Unter Windows XP:
Sie kdnnen die integrierten Audiofunktionen direkt nutzen
und einrichten:
AMCAP->Gerat->USB2.0-Kamera

- Unter Windows 2000:
Diese Windows-Version unterstitzt die USB
2.0-Audioklasse nicht. Sie mussen ein eigenes Mikrofon an
den Mikrofonanschluss des PCs anschlieRen. Danach folgt
die Einrichtung:
27



AMCAP-Gerat->Soundkarte

Zweiter Schritt: Erfassung—>Audio erfassen->Erfassung
starten

2. Schnappschuss:

(1) Zum Aufnehmen eine Schnappschusses driicken Sie auf die

Schnappschuss-Taste oder verwenden das Symbol in der
Taskleiste.

(2) Bild mit 2 Megapixeln auf 4 Megapixel erweitern
(interpolieren):

Dazu miissen Sie zunéchst die ,Ausgabegrof3e” auf 1,3 M (1280 x
1024) einstellen.
AMCAP - Optionen - Videoerfassung > Ausgabegréfle

AnschlieBend wahlen Sie ,VGA-Schnappschuss* (2 M oder 4
M) und driicken zum Erfassen auf die Schnappschuss-Taste.

AMCAP - Optionen - Videoerfassungsfilter >
VGA-Schnappschuss

28
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Spezialeffekte

1. Effekte:
Um mehr aus lhren Bildern zu machen, stehen Ihnen einige
Effekte zur Auswahl. Mit den folgenden Schritten stellen Sie die

,Effektfunktionen” ein.
AMCAP - Optionen -> Videoerfassungsfilter > Effekte

2. VergroRRern/Verkleinern-Funktionen (Zoom)
Zum VergroRRern und Verkleinern folgen Sie den Anweisungen

auf dem Bildschirm.
AMCAP -> Optionen - Videoerfassungsfilter > Zoom
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3. Gesicht-Nachfihrung:

Neben der Zoom-Funktion (zum VergréRern und Verkleinern)
steht lhnen eine spezielle Funktion zum Nachfihren der Kamera
zur Verfiigung. Setzen Sie ein Hakchen bei
sGesicht-Nachfiihrung aktivieren“, bewegen Sie sich danach
mindestens 10 Sekunden lang nicht mehr. Das Objektiv stellt
daraufhin auf Ihr Gesicht scharf und folgt jeder Ihrer
Bewegungen.

AMCAP -> Optionen - Videoerfassungsfilter >
Gesicht-Nachfuhrung aktivieren

30
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Hinweise:

1. Anpassung an die Stromversorgung: Wahlen Sie je nach lokaler
Netzfrequenz oder Videosystem ,50 Hz" (diese Frequenz wird in
Deutschland und fur PAL-Signale verwendet) oder ,60
Hz" (NTSC-Signale). Auf diese Weise kdnnen Sie die Bildqualitat
verbessern.

AMCAP - Optionen - Videoerfassungsfilter > Einstellungen

2. Damit lhre Kamera storungsfrei arbeiten kann, laden Sie das
neueste ,Service Pack" herunter: Start > Windows Update.

3. Falls Sie das Symbol in der Taskleiste schlieRen, miissen Sie den
Computer neu starten, damit das Symbol wieder angezeigt wird.
4. Die USB 2.0-Audioklasse (integriertes Audio) wird nur von

Windows XP SP2 unterstitzt.

5. Die ArcSoft-Anwendungssoftware unterstutzt Video- und
Audioaufnahmen nur unter Windows XP SP2. Unter Windows
2000 konnen nur Videoaufnahmen gemacht werden.

6. Zoom- und Gesicht-Nachfihrungsfunktionen werden nur in der
VGA-Aufldsung (640 x 480) unterstitzt .

7. Die Erfassung von 1,3/2/4 M-Standbildern funktioniert nur Gber
einen USB 2.0-Port.

8. Es kann vorkommen, dass die Schnappschussfunktion unter
Windows XP nicht gleich nach der Installation funktioniert. Bitte
Uberpriifen Sie zunachst die Videoerfassungsfunktion tber
AMCAP oder starten Sie Windows neu.
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Comenzar

Visién delantera/ posterior

Base

Enfoque
Conector

usB
LED

Instantanea

Disposicion del equipo eléctrico y electrénico viejo (aplicable en
la unién europea y otros paises europeos con los sistemas de la
coleccion separadas)

Este simbolo en el producto o en su empaquetado indica que este producto
no sera tratado como basura de casa. En lugar sera entregado al punto
aplicable de la coleccion para el reciclaje del equipo eléctrico y electrénico.
Asegurandose que este producto es dispuesto correctamente, usted ayudara
a prevenir las consecuencias negativas potenciales para el ambiente y la
salud humana, que se podrian causar de otra manera por la direccion inutil
inadecuada de este producto. El reciclaje de materiales ayudara a conservar
recursos naturales. Para una informacién mas detallada sobre el reciclaje de
este producto, por favor entre en contacto con su oficina local de ciudad , su
servicio de la disposicién inttil de la casa o la tienda en donde usted compré
el producto.
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Instalar el software

»>Requisitos del sistema operativo
Windows XP SP2 (compatible con la clase de audio USB2.0)
Windows 2000 (no compatible con la clase de audio USB2.0)

Atencion:
Asegurese de instalar el controlador ANTES de enchufar la
camara al puerto USB.

1. Inserte el CD de software de la camara Web PC1331 en la
unidad de CD-ROM de su PC.

Espafiol

2. El programa de instalacion se ejecutara automéaticamente. Si
la instalacién no se inicia automaticamente, ejecute el archivo
“Setup.exe” desde el directorio raiz del CD-ROM.

et L P TR Sk




Instalar el controlador

Después de instalar el software, aparecera el cuadro de
didlogo “ArcSoft Software suite” (Aplicaciones de software
ArcSoft) en la pantalla. Haga clic en el icono “PC Camera
Driver” (Controlador de la camara de PC) para instalar el
controlador del dispositivo y, a continuacion, siga las
instrucciones de la pantalla.

gt F y [ i o AT e
Bl F T " [ a i 0 Pl L

Seleccione “Yes, | want to restart my computer now” (Si, deseo
reiniciar mi equipo ahora). A continuacion, haga clic en “Finish”
(Finalizar) para completar la instalacion del controlador.

»Instalar las aplicaciones ArcSoft

1.

Haga clic en el icono “ArcSoft WebCam Companion” (Material
complementario de la camara Web ArcSoft) y siga las
instrucciones de la pantalla para instalar las aplicaciones de
software.
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2.

3.

El asistente instalar4 el conjunto de aplicaciones ArcSoft:
cuatro aplicaciones de software al mismo tiempo.

Después de la primera instalacién, el sistema se reiniciara y
un nuevo icono aparecera en el escritorio.

&
B

Instalar el hardware

1.

Enchufe el cable USB incluido en la camaray en el puerto USB de
su PC por separado después de instalar la camara PC1331 y
reinicie el equipo. Para evitar un valor bajo de voltaje, se
recomienda enchufar el conector del cable USB al puerto USB
directamente en su PC.

Puede encontrar un icono residente en la barra de
herramientas del escritorio. Al presionar este icono, puede
comprobar la conexién de la camara Web y el estado de
trabajo.

Atencion:

Reinicie Windows si no puede activar AMCAP cuando
presione el botén Instantanea en Windows XP o actualice
Windows con el Service Pack mas reciente.
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3. Cuando presione el boton de instantanea, el indicador LED de la
camera se iluminara y aparecera el cuadro de dialogo “AMCAP” si
la instalacion se ha realizado correctamente.

Atencion:
Si tiene varios dispositivos de imagen en el sistema,

seleccione “CamMaestro” como el dispositivo de camara
de PC.

Descripcion de funciones

Puede utilizar AMCAP o el icono residente para seleccionar

todas las funciones que necesite.

Icono residente

_*Bjcz

1. Grabar:
(1) Grabar video : Captura—>Iniciar captura-> Detener captura

(2) Grabar video y audio:
Primer paso: En primer lugar, seleccione el micréfono.
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-Usuario de Windows XP:

Puede utilizar el audio integrado directamente y, a

continuacion, seleccionar las siguientes opciones:

AMCAP->Device (Dispositivo)>USB2.0 Camera
-Usuario de Windows 2000:

Windows no admite la clase de audio USB2.0, por lo que
tendra que enchufar su propio micréfono en el conector

correspondiente de su PC. A continuacion seleccione las
siguientes opciones:

AMCAP-> Dispositivo-> tarjeta de sonido

Segundo paso: Capturar-> Capturar audio—>Iniciar captura

Espafiol

Atencién:

(1) Puede seleccionar cualquier carpeta para colocar
los archivos grabados. Definala antes de uniciar la
grabacion: File (Archivo) > Set capture file
(Establecer archivos de captura)

(2) Asegurese de que ha cerrado el "Reproductor de
Windows Media" antes de realizar la grabacion.

38



2. Instantanea:

(1) Presione el botén Instantanea o el icono residente para
realizar la captura.

(2) Puede interpolar imagenes estaticas a 2,0 6 4,0
megapixeles:
Previamente tendra que establecer el “tamafio de salida” en
1,3 megapixeles (1280x1024).
AMCAP - Opcién > Pin de captura de video - Tamafio de
salida

A continuacion, establezca el valor de 2 0 4 megapixeles en la
opcién "VGA Snapshot” (Instantdnea VGA) y presione el boton
Instanténea para realizar la captura.

AMCAP -> Opcion - Filtro de captura de video - Instantanea
VGA
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Efectos especiales

1. Efectos:

Dispone de una gran variedad de efectos para enriquecer las

imagenes. Siga estos pasos para establecer las “Funciones de
efectos”.

AMCAP ->Opcidn -> Filtro de captura de video > Efectos

2. Funciones Acercar y alejar:

Siga las instrucciones de la pantalla para seleccionar las
funciones Acercar y Alejar.
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AMCAP -> Opcion - Filtro de captura de video > Zoom

3. Rastreo facial:

Al lado de la funcién Zoom, se encuentra la funcién especial
Rastreo facial. Active la opcion “Habilitar la funcion de rastreo
facial” y, a continuacién, permanezca en ese estado al menos 10
segundos. El objetivo enfocara su cara y rastreara todos los
movimientos.

AMCAP - Opcion - Filtro de captura de video - Habilitar
funcién de rastreo facial

41



Aviso: ajuste de escala

1. Ajuste de la fuente de alimentacion:
Elija el modo de “50 Hz" o “60 Hz" en funcién de la fuente de
alimentacion o del sistema de sefial de salida de video para
evitar imagenes borrosas.

AMCAP - Opcion - Filtro de captura de video = Configuracion

2. Descargue la actualizacién mas reciente de “Service Pack”
(mediante Start (Inicio) = Windows Update) para que la camara
funcione sin problemas.

3. Si el icono residente esta disparado, debera reiniciar el equipo
para disponer de esta funcion.

4. La compatibilidad con la clase de audio USB 2.0 (audio
integrado) solamente esta disponible con Windows XP SP2.

5. Para las aplicaciones de software ArcSoft, solamente se puede
grabar video y audio en Windows XP SP2. Con Windows 2000
solamente puede grabar video.

6. Las funciones Zoom y Rastreo facial estan disponibles en el
modo VGA (640x480).

7. La captura de imagenes estaticas a 1,3, 2 y 4 megapixeles
solamente se pueden realizar por el puerto USB2.0.

8. Intente que Instantanea funcione con normalidad en la primera
instalacion de Windows XP. Compruebe primero la funcién de
captura de video con AMCAP o reinicie Windows.
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COMECANDO

Vista de Frente/ Traseira
Suporte

Lente
Conector
LED
UsB
Botéo para
tirar fotografias

Destruicéo de Equipamentos Elétricos& Eletronicos Velhos
(Em vigor na Unido de Europa e outros paises europeus

— com sistemas separados de colec¢ao)

Este simbolo no produto ou na sua embalagem indica que este produto néo
pode se trata como detritos domésticos. Em vez disso, ele pode passa se ao
ponto de colec¢do em vigor para reciclagdo dos equipamentos eléctricos e
electronicos. Com assegurando gque este produto é disposto correctamente,
0 senhor vai ajudar a prevenir consequéncias potenciais negativas para o
meio e saude humana, o que pode se causar de outro modo pelo tratamento
inapropriado dos detritos deste produto. A reciclag8o destes materiais vao
ajudar a salvar recursos naturais. Por mais informacdes pormenorizadas
sobre reciclagdo deste produto, por favor, contacte escritério da sua cidade
local, servigo de disposto do seu detrito doméstico ou a loja onde comprou o
produto.
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Instalacdo do software

Requisitos em termos do sistema operativo
Windows XP SP2 (suporta audio da classe USB2.0)
Windows 2000 (n&o suporta audio da classe USB2.0)

Atencéo:
Instale o controlador ANTES de ligar a camara a porta USB.

1. Introduza o CD contendo o software da Web Cam PC1331 na
unidade de CD-ROM do computador.
2. O programa de instalagdo é automaticamente executado. Se

tal ndo acontecer, execute o ficheiro “Setup.exe” que encontra
no directério raiz do CD-ROM para proceder a instalagdo.
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Instalacéo do controlador

1.

ApoOs a instalac@o do software, a caixa de dialogo do “ArcSoft
Software suite” é apresentada no ecra. Clique no botdo “PC
Camera Driver” (Controlador da PC Cam) para instalar o
controlador do dispositivo  seguindo as instrugbes

apresentadas no ecra.

Scwp bal wlien em b e L “

Seleccione a opgdo “Yes, | want to restart my computer now"
(Sim, quero reiniciar o meu computador agora.) e depois
clique em “Finish” (Concluir) para concluir a instalagdo do
controlador.

Atencéo:
Recomendamos-lhe que reinicie o computador depois
de instalar o controlador.

Instalacdo do ArcSoft Suite

1.

Clique no botdo “ArcSoft WebCam Companion” e siga as
instrugcbes apresentadas no ecré para instalar o software.
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2. O assistente ird instalar o ArcSoft Suite: um conjunto de
guarto aplicacdes que séo instaladas ao mesmo tempo.

3. Apo6s a instalagdo inicial, o sistema é reiniciado € um novo
icone é apresentado no ambiente de trabalho.

il

Instalacdo do hardware

1. Apé6s a instalagdo do controlador da PC1331 ligue o cabo USB
incluido a camara e a porta USB do PC, de seguida reinicie o
computador.  (Para evitar tensdo  eléctrica  baixa,
recomendamos-lhe que ligue directamente o conector do cabo
USB a porta USB do PC.)
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2. Encontrard um icone residente na barra de ferramentas do
ambiente de trabalho. Prima este icone para verificar o estado
da ligacéo e de funcionamento da Web Cam.

Atencdo:

Reinicie o0 Windows caso ndo consiga activar a aplicagao
AMCAP ao premir o botdo para tirar fotografias no
ambiente Windows XP ou actualize o seu Windows com o
service pack mais recente.
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Prima o bot&o para tirar fotografias, o LED azul acende e a
caixa de dialogo “AMCAP” serd apresentada apos a
instalacao ter sido concluida com éxito.

Atencéo:
Se tiver mais do que um dispositivo para captura de

imagens instalado no seu computador, seleccione a
opcéo “CamMaestro” para predefinir a PC Cam.

Descricdo das funcdes

Pode utilizar a aplicacdo AMCAP ou o icone residente para
seleccionar todas as funcdes de que necessita.

Portugués

icone residente
@ -

1.Gravar:

(1) Gravar video: Capture->Start Capture->Stop Capture
(Capturar=>Iniciar captura->Para captura)
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(2) Gravar video e audio:
12 etapa: Comece por seleccionar o microfone.

-No Windows XP:
Pode utilizar directamente a fungdo de audio incorporada
e depois escolher:
AMCAP->Dispositivo>Céamara USB2.0

-No Windows 2000:
O Windows 2000 n&o suporta o audio de classe USB2.0
pelo que tera de ligar o seu proprio microfone ao
respectivo conector existente no PC. Depois escolha:
AMCAP->Dispositivo->Placa de som

22 etapa: Capturar->Capturar audio->Iniciar captura

uod

Atencéo:

(1) Pode seleccionar qualquer pasta para
armazenamento dos seus ficheiros gravados.
Siga as etapas seguintes antes de comecar a
gravar. File-> Set capture file (Ficheiro> Definir
ficheiro de captura)

(2) Certifique-se de que fechou 0” Windows Media
Player” antes de comecar a gravar.
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2.Tirar fotografias:

(1) Prima o botdo para tirar fotografias ou prima o icone
residente para capturar a imagem.

(2) A imagem pode ser interpolada para 2,0 M ou 4,0 M pixeis:
Em primeiro lugar, tera de definir a opcdo “Output size”
(Tamanho de saida) para 1,3 M (1280x1024).

AMCAP - Option - Video Capture Pin - Output size

(AMCAP - Opcédo - Pino para captura de video - Tamanho
de saida)

De seguida defina a opgdo "VGA Snapshot” (Fotografia VGA)
para 2 M ou 4 M e prima o botado para tirar a fotografia.

AMCAP - Opcéo - Filtro para captura de video - Fotografia
VGA

Efeitos especiais
1. Efeitos:

Existem véarios efeitos que pode utilizar para enriquecer as suas
fotografias. Siga as etapas seguintes para definir a opcao
“Effects” (Efeitos).

AMCAP - Opcao->Filtro para captura de video-> Efeitos
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2. Mais zoom/menos zoom:
Siga as instrucdes apresentadas no ecrd para seleccionar a
opgéo Zoom (Zoom).

AMCAP - Opcéo - Filtro para captura de video - Zoom

uod
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3. Rastreio do rosto:

Para além da fungdo de zoom, existe uma outra fungdo especial
que da pelo nome de "Face Tracking" (Rastreio do rosto).
Assinale a opgdo “Enable Face Tracking function” (Activar a
funcéo de rastreio do rosto) e de seguida permanega na mesma
posicdo durante pelo menos 10 segundos. A lente focara o seu
rosto fazendo o rastreio de cada movimento do mesmo.

AMCAP > Opgédo > Filtro para captura de video ->Activar a
funcao de rastreio do rosto

Aviso: Multiplicador de frequéncias

1.Ajuste da fonte de alimentagéo:
Escolha a opc¢éo “50Hz” (50 Hz) ou “60Hz” (60 Hz) de acordo
com a fonte de alimentacéo de que dispde ou de acordo com o
sistema de saida do sinal de video para evitar imagens
desfocadas.
AMCAP->Opc¢éo -> Filtro para captura de video> Defini¢cdes

2.Transfira 0 mais recente “Service Pack” (em Iniciar - Windows
Update) para que a camara continue a funcionar sem
problemas.

3.Se o icone residente estiver desactivado, terd de reiniciar o
computador para dispor desta funcéo.
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4.0 audio de classe USB 2.0 (audio incorporado) apenas €
suportado pelo Windows XP SP2.

5. Em termos do software de aplicagao ArcSoft, as funcbes de
gravacao de video e de audio apenas sdo suportadas pelo
Windows XP SP2. Ja o Windows 2000 apenas suporta a
funcao de gravagao de video.

6. As fungbes Zoom (Zoom) e Face tracking (Rastreio do rosto)
apenas sao suportadas pelo modo VGA (640x480).

7. A captura de imagens com uma resolugdo de 1,3 M/2 M/4 M
apenas pode ser feita através da porta USB2.0.

8. Se 0 botdo para tirar fotografias ndo funcionar normalmente
aquando da instalagdo inicial no Windows XP, verifique a
funcdo de captura de video com a aplicacdo AMCAP ou
reinicie o Windows.
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STA PER COMINCIARE

Vista di fronte/ Retro

Base

Fuoco
LED * Connettore
UsB

Acquiszione
Disposizione dell’Old Elettrico &Equipaggiamento
Elettrico (Applicabile nell'Unione Europea e gli altri paesi
europei con sistemi di raccolta separati)

|

Questo simbolo sul prodotto o sul suo imballare indica che questo prodotto
non sara trattato come perdita familiare. Sara invece trasmesso al punto di
raccolta applicabile per il riciclaggio di apparecchiatura elettrica ed elettronica.
Da assicurare che questo prodotto e disposto di correttamente, aiuterete a
evitare conseguenze negative potenziali per 'ambiente e per salute umana,
che potrebbe essere causato altrimenti da gestione di perdita non
appropriata di questo prodotto. Il riciclaggio di materiali aiutera a conservare
risorse naturali. Per informazioni piu dettagliate su riciclaggio di questo
prodotto, per favore contattate il vostro ufficio di citta locale, il vostro servizio
di disposizione di perdita familiare o il negozio dove avete acquistato il
prodotto.
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Istallazione del software

Requisiti del sistema operativo

Windows XP SP2 (supporta la classe audio USB2.0)
Windows 2000 (non supporta la classe audio USB2.0)

Attenzione:

webcam alla porta USB.

Assicurarsi di installa il driver PRIMA di collegare la

1. Inserire il CD software WebCam PC1331 nell'unita CD-ROM

del computer

2. Il programma d'installazione si avviera automaticamente. Se

linstallazione non si awvia, eseguire

directory principale del CD-ROM.

“Setup.exe”
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1.

Installazione del driver

Dopo avere installato il software, sullo schermo appare la
finestra di dialogo “ArcSoft Software suite”. Fare clic sull'icona
“PC Camera Driver” per installare il driver del dispositivo, e
poi seguire le istruzioni su schermo per completare
l'installazione.

ey bl iy e b eww L “

Selezionare "Yes, | want to restart my computer now" (Riavvia
il computer). Fare clic su "Finish" (Fine) per completare
l'installazione del driver.

Attenzione:
Si raccomanda di riavviare il computer dopo avere
installato il driver.

Installazione di ArcSoft suite

Fare clic sullicona “ArcSoft WebCam Companion”, e
seguire le istruzioni su schermo per installare il software
applicativo.

La procedura guidata installerd ArcSoft suite: quattro
software in una sola volta.
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3.

Dopo linstallazione iniziale, il sistema si riavvierd; sul
desktop ci sara una nuova icona.

il

Installazione dell'Hardware

1.

Dopo avere installato il driver PC1331 ed avere riavviato il PC,
collegare il cavo USB fornito in dotazione alla Webcam e ad
una porta USB del PC. (Per evitare cali di tensione, si
raccomanda di collegare il cavo connettore del cavo USB
direttamente alla porta USB del PC.)

Sulla barra degli strumenti del desktop si trovera un’icona
residente. Facendo clic sull'icona si pud controllare lo stato
della connessione ed operativo della WebCam.

Attenzione:

Riavviare Windows se non si riesce ad attivare AMCAP
quando si preme il pulsante Snapshot (Istantanea) in
Windows XP, oppure aggiornare Windows con il Service
Pack piu recente.
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3.  Premere il tasto Snapshot (Acquisizione), il LED blu si
illuminera e — al termine dell'installazione — apparira la finestra
di dialogo “AMCAP".

Attenzione:

Se sul sistema sono installati piu dispositivi d’acquisizione
immagine, selezionare “CamMaestro” quale driver per la
PC Camera.

Descrizione delle funzioni

Si pud usare licona AMCAP oppure quella residente per
selezionare tutte le funzioni necessarie.

Icona residente
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1.Registrazione:

(1) Registrazione video: Acquisizione—> Avvia acquisizione -
Termina acquisizione
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(2) Registrazione video e audio:
Fase 1: Per prima cosa selezionare il microfono.

-Utenti Windows XP:
Si puo usare direttamente I'audio integrato e poi

impostare:
AMCAP - Dispositivo > USB2.0 Camera

-Utenti Windows 2000:
Windows non supporta la classe audio USB2.0 e sara
necessario collegare un microfono al connettore microfono

del PC. Poi impostare:
AMCAP ->Dispositivo > Scheda audio

Fase 2: Acquisizione - Acquisizione audio > Avvia

acquisizione

Attenzione:

(1) | file registrati possono essere archiviati in qualsiasi
cartella. Impostare la cartella prima di avviare la

capture file (Imposta
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registrazione. File> Set

acquisizione file)
(2) Assicurarsi che "Windows Media Player” sia ciuso,

quindi si pud proseguire con al registrazione.
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2.Istantanea:

(1) Premere il tasto Snapshot (Acguisizione) o premere licona residente
per eseguire 'acquisizione.
(2) Interpolazione di fotografie su 2.0M o0 4.0M pixel:
Per prima cosa sara necessario impostare le dimensioni
d’output su 1.3M (1280x1024).
AMCAP - Opzioni = Acquisizione video - Dimensioni d’output
Poi impostare I'acquisizione VGA su 2M o 4M, e poi premere il
tasto Snapshot (Istantanea per acquisire.

AMCAP -> Opzioni - Filtro acquisizione video - Acquisizione
VGA

Effetti speciali

1.Effetti:
Ci sono a disposizione piu effetti per arricchire le immagini.
Attenersi alle fasi che seguono per impostare le funzioni degli
effetti.
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AMCAP - Opzioni) - Filtro acquisizione video > Effetti
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2.Funzioni d'ingrandimento/riduzione:
Seguire le istruzioni su schermo per selezionare le funzioni
d’'ingrandimento/riduzione.
AMCAP - Opzioni > Filtro acquisizione video - Zoom
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3. Focalizzazione viso:

Oltre alle funzioni zoom, c’e€ una funzione speciale chiamata
Focalizzazione viso. Selezionare “Enable Face Tracking
function” (Abilita funzione di focalizzazione viso) e restare fermi
per almeno 10 secondi. L'obiettivo mettera a fuoco il vostro viso
€ poi ne seguira tutti i movimenti.

AMCAP - Opzioni - Filtro acquisizione video - Abilita funzione
di focalizzazione viso

Avviso: proporzioni

1. Regolazione alimentatore:
scegliere “50Hz” o “60Hz” in base ai requisiti della rete
elettriche oppure in base al segnale d’output video per evitare
immagini sfuocate.

AMCAP -> Opzioni - Filtro acquisizione video - Impostazioni
2. Scaricare gli aggiornamenti piu recenti del “Service Pack” (da

Start > Windows Update) per mantenere il funzionamento
appropriato della Webcam.
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3. Se si chiude I'icona residente, sara necessario riavviare il
computer per ottenere di nuovo la funzione.
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4.Solo Windows XP SP2 supporta la classe audio USB 2.0 (audio
integrato).

5. Solo Windows XP SP2 supporta la funzione di registrazione
audio e video del software applicativo ArcSoft. Windows 2000
eseguire solo la registrazione video.

6. Supporto della funzione Zoom e Face tracking (Focalizzazione
viso) in modalita VGA (640x480).

7. Acquisizione immagini 1.3M/2M/4M solo tramite porta USB2.0.

8. In caso di funzionamento anomalo della funzione Snapshot
(Acquisizione) dopo l'installazione iniziale su Windows XP,
controllare la funzione d’acquisizione video di AMCAP, oppure
riavviare Windows.
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